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Objectives:

1. Consider the different components (transpiration, interception and evaporation) that
comprise measurements of evapotranspiration.

2. Compare water use rates and water use efficiency to address questions of ecosystem
function.

3. Practice visualizing and interpreting the data from ECOSTRESS.
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Motivation For Today’s Tutorial: Natural Climate Solutions

Natural climate solutions are actions that scientists have identified to protect, manage, and restore

nature while reducing greenhouse gas emissions and storing carbon. Combined with the transition away

from fossil fuels, natural climate solutions offer immediate and cost-effective ways to address the climate

crisis, while also supporting healthy and thriving ecological communities and ecosystems.

Examples of natural climate solutions include reforestation, agriculture, and timber management,

and protection of ecosystems known to capture and store large amounts of carbon. Reducing carbon

emissions into the atmosphere is key to achieving the goal of the Paris Climate Agreement of maintaining

warming below 2 � C. Scientists use remote sensing data, such as evapotranspiration and water use

efficiency from ECOSTRESS, to help assess the impact of natural climate solution actions.

9. PLANT WATER-USE EFFICIENCY FROM ECOSTRESS 2



I.C.E.C.R.E.A.M. TUTORIALS
Observing Earth from Above (Env 329) v24.06

Schmid College of Science and Technology, Chapman University

9.1 ACCESSING ECOSTRESS ET COMPONENT & WUE DATA THROUGH A⇢⇢EEARS

9.1.1 ECOSTRESS Evapotranspiration (ET) & Water Use Efficiency (WUE) Data Variables

In the last tutorial, we learned that ECOSTRESS uses land surface temperatures to estimate evapotranspi-

ration (ET), the sum of all processes that return water from the land surface to the atmosphere (evaporation

+ transpiration). The Level 3 (ECO3) ET data that we worked with last time (ETinst & ETdaily ) represent the

total ET, but ECOSTRESS also has data that allow us to track the individual components of ET:

• ETcanopy = transpiration of water from the leaves (through stomata in higher plants)

• ETinterception = evaporation of water off of the surface of the plants (e.g., rain on the surface of a leaf)

• ETsoil = evaporation of water from the soil

Water use efficiency (WUE), or the amount of carbon plants take up per unit of water lost, is a Level 4

(ECO4) ECOSTRESS data product that is derived, in part, from Level 3 (ECO3) ECOSTRESS daily ET

data:
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Today’s Study System: Southern Pine Forests

• Longleaf pine (Pinus palustris) ecosys-

tems once occupied 90 million acres in the

Southeastern United States.

• Timber harvest, land conversion, and wild-

fire suppression reduced the longleaf pine

ecosystems to only 3.2 million acres. Fire

is a part of their natural life cycle.

• Characterized by a tall overstory and a

grassy forest floor, there has been a recent

movement to restore these forests.

• Scientists have discovered that longleaf

pine can tolerate droughts and capture

more carbon than other trees, which means

that this ecosystem as potential as a natural

climate solution, especially since forests of

the Southeast are already known to capture

more carbon than any other forest region

in the U.S.

Hypotheses

• Today, we are going to compare two forests.

Loblolly pine is a species used by the for-

est products industry and longleaf pine is

a species researchers hope to restore to

mitigate climate change. We are going to

compare longleaf pine in a wet coastal site

to loblolly pine in a dry upland site.

• Given what you have just read, write pre-

dictions about:

1) How would you predict the water use

efficiency to compare between the two

species? Why might you expect this?

2) How would you predict the transpiration,

evaporation, and interception (i.e., the com-

ponents of ET) to compare between the

two sites? Why might you expect this?
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A Quick Note About Models

• George E. P. Box, a British statistician,

once wrote: “All models are wrong, but

some models are useful. So the question

you need to ask is not Is the model true?
(it never is) but Is the model good enough
for this particular application?”

• What he is saying here is that a model is

an over-simplification or approximation of

reality and hence can not possibly reflect all

of the complex physical and biological com-

ponents of the universe. However they can

be useful when paired with an appropriate

application.

• The ECOSTRESS satellite measures land surface temperature with a Thermal Infrared Ra-

diometer (TIR). After that, each of the products we work with (evapotranspiration, water use

efficiency, and evaporative stress index) are the outputs of model algorithms, formulas carefully

derived to estimate quantities of interest, but are in fact, just approximations of the quantities.

9.1.2 Requesting loblolly pine ET & WUE data from A⇢⇢EEARS

The procedure for downloading the ET component and the WUE data through the A⇢⇢EEARS interface is

the same as in the previous tutorials on land surface temperature.

1. First, begin by downloading these two GeoJSON files and saving them somewhere you can remember

(as always, I suggest creating a folder for each tutorial):

1. Longleaf Pine (South Carolina Wet Coastal Environment): LongleafSC.geojson

2. Loblolly Pine (North Carolina Dry Upland Environment): LoblollyNC.geojson

NOTE: Depending on your web browser, you may need to right click and select Save as. Some web

browsers may even display the contents of the GeoJSON file instead of prompting you to save it. If this

happens, you can select the File dropdown menu and click on Save as.

2. Go to https://appeears.earthdatacloud.nasa.gov/ and login with your credentials.
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3. Use the Extract dropdown menu to select Area. Next, select Start a new request.

4. Enter a useful name for the request you are going to submit, maybe something like “Loblolly ET and

WUE”.

5. Drag and drop (or use the click here to select the file link) to upload the GeoJSON file LoblollyNC.geojson.

The map should be updated with a polygon around a forest in North Carolina.

6. Update the Start and End Date Fields for our preselected date of interest: 07/21/2022 to 07/21/2022.

7. Under Select the layers to include in the sample type the words “ECOSTRESS” and “Evapotranspiration.”

Select ECOSTRESS Evapotranspiration PT-JPL. Click on the “+” signs to add the following layers to your

cart:

• EVAPORTRANSPIRAT ION PT JPL ETcanopy

• EVAPORTRANSPIRAT ION PT JPL ET interception

• EVAPORTRANSPIRAT ION PT JPL ETsoil
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Next, clear the selection of the current category using the small “x” to the right of the ECOSTRESS

Evapotranspiration PT-JPL box.

Then, under Select the layers to include in the sample type the words “ECOSTRESS” and “WUE.” Select

ECOSTRESS Water Use Efficiency. Click on the “+” signs to add the following layers to your cart:

• Water Use Efficiency WUEavg

Clear the selection of the current category using the small “x” to the right of the ECOSTRESS Water Use

Efficiency box.

8. Under Output Options, we want to use GeoTIFF (Geographic Tagged Image File Format; essentially an

image file where the corresponding geographic information is embedded in the file) and Native Projection

for projection.

9. Click Submit to complete the data request. At the top, you should see a green banner:

9.1.3 Requesting longleaf ET & WUE data from A⇢⇢EEARS

10. In the meantime, we are going to create a second request for this tutorial, as we need data for longleaf

pines to compare to the loblolly pine data we just requested. Use the Extract dropdown menu to select

Area. Next select Start a New Request. Enter a useful name to distinguish this request from the other,

maybe something like “Longleaf ET and WUE”. Drag and drop (or use the click here to select the file link) to

upload the GeoJSON file LongleafSC.geojson. The map should be updated with a polygon around a forest

on the coast of South Carolina.

11. Repeat steps 6 - 9 above to retrieve the ET component and WUE data for the longleaf pine site on

7/26/2022.

NOTE: You may have noticed the dates are different for the longleaf and loblolly sites. Unfortunately, the

two sites are too far apart to have a satellite overpass on the same day.

12. Use the Explore drop-down at the top to monitor the status of your request. Requests will likely go

quickly, given that it is only one day’s worth of data.
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9.1.4 Visualizing loblolly pine ET Component Data in A⇢⇢EEARS

13. When your first request (“Loblolly ET and WUE”) is complete, use the link on the Explore page to access

the details. Let’s check out the data. First, a quick review of boxplots:

14. Our goal for the analysis of the evapotranspiration components is not to visualize the data on a map,

but rather to compare the differences between the two forest ecosystems (loblolly vs. longleaf pine) as a

whole. As a result, there is no need to download the GeoTIFF files and import the layers into QGIS. We can

explore the data with the A⇢⇢EEARS interface to get the information we need.

15. First, select the EVAPOTRANSPIRAT ION PT JPL ETcanopy layer:

Notice that the median value for the canopy component of evapotranspiration is 49.57. This means that

the median value for pixels in our area of interest is 49.57, which means that 49.57% of the total evapo-

transpiration (the “EVAPOTRANSPIRATION PT JPL ETinst” variable) is coming from canopy transpiration.

Although the overall distribution of the data is skewed towards higher values, there is no need to worry, as

the range of the data (minimum to maximum observed value) is about 3%. Since our analysis is mostly

concerned with the relative percentages of the different components of ET (canopy vs. interception vs. soil),

it is reasonable to simply use the median value.

16. Next, select the EVAPOTRANSPIRAT ION PT JPL ET interception layer.
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Here, we observe that 41.24% of total evapotranspiration comes from interception.

17. Finally, select the EVAPOTRANSPIRAT ION PT JPL ETsoil layer.

So, the overall breakdown for the individual components of evapotranspiration is 49.57% canopy transpira-

tion, 41.24% interception evaporation, and 9.15% soil evaporation. You will report this in the write-up that

accompanies your “Map of the Week” assignment along with longleaf pine data that you will complete on

your own.

9.1.5 Downloading loblolly pine WUE Data

18. From the Layer dropdown menu, choose “Water Use Efficiency WUEavg”, then expand the Request

box above by clicking on the caret. Click the download button to continue.

19. Select the following filename: ECO4WUE.001 Water Use Efficiency WUEavg doy2022202224219 aid0001.tif.
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Download the files using the Download button, that for some reason does not look much like a button, on

the top right corner of the screen. Save the files somewhere you can remember.

9.2 VISUALIZING ECOSTRESS WUE DATA IN QGIS

9.2.1 Adding a Google Satellite Basemap

20. Open QGIS and start a new project by selecting the Project menu, then New.

21. To add a basemap, find the HCMGIS menu bar, select Basemap, then pick your preferred map. For

today’s map, we will use Google Satellite. Note that clicking on a basemap type automatically adds a new

layer to your map, as seen in the layer browser window.

9.2.2 Add in the Water Use Efficiency (WUE) layer

22. Use the browser window to find the folder where you saved the WUE file:

ECO4WUE.001 Water Use Efficiency WUEavg doy2022202224219 aid0001.tif

23. Double-click the ECO4WUE.001 Water Use Efficiency WUEavg doy2022202224219 aid0001.tif file to

add it to your map. Again, notice that they are now also listed in the Layers window.

NOTE: Our loblolly data is at a pretty fine scale and might be hard to see if your basemap is zoomed out

at the global scale. QGIS can automatically zoom to your layer’s area of interest by right clicking (ctrl-click

on Mac) on the layer and selecting Zoom to Layer(s).

24. Now you have ECOSTRESS WUE data on your map, but we need to change it from grayscale.

Right-click (ctrl-click on Mac) on the layer name in the Layers window and select Layer Properties.

25. On the menu bar to the left, select Symbology and change Render type to Singleband pseudocolor.
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26. QGIS has automatically determined the minimum and maximum values from the datafiles; however, we

are going to want to compare two types of ecosystem and we need to match them. Specify 0.35 as the

minimum and 1 as the maximum.

27. Change the color ramp to something that you feel communicates WUE. I selected the “Blues” option.

Click apply, then ok.

28. Finally, add the border from LoblollyNC.geojso by double clicking on it in the Browser window. Right-click

(ctrl-click on Mac) on the layer in the Layers window and change the symbology to outline red.

9.3 ADD MAP ELEMENTS

29. Following the procedure described in Tutorial #7 : Adding Elements To Maps, make a professional

map complete with scalebars, labels, a legend, titles, and a North arrow. This map will be your part of your

“Make a Map” assignment.

NOTE: It is not apparent in A⇢⇢EEARS, but the units for WUE are gCkg�1H2O.

9.4 MAKE THE SAME MAP FOR LONGLEAF PINES

30. Follow the same procedure (steps 13 - 29) for our other request, “Longleaf ET & WUE”:

1. Explore data for the ET components of the longleaf pine ecosystem in the A⇢⇢EEARS interface to

determine the relative contributions of the canopy, interception, and soil to total evapotranspiration.

Note the differences between longleaf and loblolly. Submit this as part of your write-up for the “Map of

the Week”.

2. Download the water use efficiency GeoTIFF for longleaf pines.

3. Visualize these WUE data in QGIS.

4. Make a second professional map with the same color ramp scale for the WUE of the longleaf pine

complete with scalebars, labels, a legend, titles, and a North arrow.

5. Submit these two maps (one for longleaf, one for loblolly) as part of your “Map of the Week” assignment

along with the write-up described below.
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Make a Map Assignments

1. Watch the YouTube Video: Careers in Observing Earth from Above - Isis Frausto-
Vicencio

2. Make a WUE map for longleaf pine of the same format as the loblolly pine map we
made in the tutorial. The map should be complete with scalebar(s), north arrow(s),
legend(s), title(s), and label(s). Submit this longleaf map alonside the loblolly we made
in the tutorial today.

3. Find a classmate and compare maps. Is your classmate doing anything differently that
can help improve your map? If so, revise accordingly!

4. Submit your water-use efficiency maps, along with a short description of your maps
and ET component data that includes your reflections on which tree species may be
better suited to mitigate climate change given any differences in water use efficiency.
Would you recommend that foresters plant longleaf pine trees instead of loblolly? Will
longleaf pines have higher growth per unit water use? Address the limitations of your
analysis.

Datafiles

In case you encountered any issues with the A⇢⇢EEARS database, here are copies of the
ECOSTRESS GeoTIFF file for the loblolly WUE:

1. ECO4WUE.001 Water Use Efficiency WUEavg doy2022202224219 aid0001.tif

And longleaf WUE:

1. ECO4WUE.001 Water Use Efficiency WUEavg doy2022207201636 aid0001.tif

Recommended Citation: Forsythe, J.D., G.R. Goldsmith, and J.B. Fisher. 2023. Observing Earth from Above
Tutorials. Chapman University. https://jeremydforsythe.github.io/icecream-tutorials/

This work is supported by funding from NASA ECOSTRESS Mission Grant #80NSSC23K0309 (I.C.E. C.R.E.A.M.:
Integrating Communication of ECOSTRESS Into Community Research, Education, Applications, and Media) and is
openly licensed via CC BY-NC.
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